Precautions for handling floppy disks

Take the following precautions when handling the KPG-7D programming software floppy disk.

• Do not touch the magnetic surface of the floppy disk.
• Do not bring any magnet or magnetic object near the floppy disk.
• Do not bend the floppy disk.
• Do not use a ballpoint pen to write on the index label of the 5.25" floppy disk.
• Do not place the floppy disk in places which are either very hot and humid or very cold and dry.
• Always put the 5.25" floppy disk back into its envelope after use.
• Always put the 3.5" floppy disk back into its case after use.
Contents

Precautions for handling floppy disks ........................................ P1

1 Preface ................................................................. P3~P7
   1-1 Overview
   1-2 Connecting the equipment
   1-3 Installing the program
   1-4 A list of the items included in this package
   1-5 READ.ME FILE
   1-6 Applicable radio models
   1-7 System Flow - chart

2 Initial settings ....................................................... P8~P11
   2-1 Starting the program
   2-2 Initial display
   2-3 Setting operational flow
   2-4 Quitting the program

3 Selecting and Inputting Data ....................................... P12~P15
   3-1 Using the arrow keys
   3-2 Using the Quick Key
   3-3 Inputting directly from the keyboard
   3-4 Selecting and inputting from the Directory

4 CHANNEL INFORMATION ........................................... P16~P20
   4-1 Overview
   4-2 Setting the various items in the CHANNEL INFORMATION screen

5 Menu ........................................................................ P21~P22
   5-1 Overview
   5-2 Opening the menu windows

6 File ........................................................................... P23~P28
   6-1 New
   6-2 Load
   6-3 Save
   6-4 Save As
   6-5 Delete
   6-6 Print
   6-7 Exit

7 Model Type ............................................................... P29~P36
   7-1 Overview
   7-2 Model type settings

8 Edit ............................................................................. P37~P50
   8-1 Overview
   8-2 Key Selection
   8-3 Scan Information
   8-4 Feature Option
   8-5 Embedded Message

9 Program ....................................................................... P51~P52
   9-1 Read
   9-2 Write

10 Set Up ..................................................................... P53~P55
   10-1 Communication port
   10-2 Display color
   10-3 Help Path

11 F1 = Help ............................................................... P56~P57
   11-1 General Help
   11-2 Keyboard Help
   11-3 Keys you can use in the Help screen
1 Preface

Contents of this chapter

| 1-1 Overview | P3 |
| 1-2 Connecting the equipment | P4 |
| 1-3 Installing the program | P5 |
| 1-4 A list of the items included in this package | P6 |
| 1-5 READ. ME FILE | P6 |
| 1-6 Applicable radio models | P6 |
| 1-7 System Flow - chart | P7 |

1-1 Overview

The KPG-7D programming software for the TK-630, TK-730, and TK-830 transceivers is supplied on both 5.25" and 3.5" floppy disks.

1. Outline of functions

   The KPG-7D programming software inputs transceiver data to a computer.
   The input data can be directly written to the TK-630, TK-730 and TK-830 transceivers when they are connected to a computer, or printed out to paper. In addition, data can be read from the transceivers for display and editing.

2. Hardware and software

   ○ Computer
     The KPG-7D software has been developed to be run on the IBM PC/XT, PC/AT, PC/PS2 computers with a RAM capacity of at least 350 KB.

   ○ Operating system
     The operating system of your computer must be IBM-DOS version 3.1 or later.

   ○ Communication port
     Your computer must have a serial communication port in order to write data to and read data from the transceiver. This serial communication port must be compatible with the IBM asynchronous communications adapter. The port used may be either COM 1 or COM 2.

   ○ Communication interface cable
     The KPG-4 communication interface cable is required to send data to and read data from the transceiver.
1-2 Connecting the equipment

This section describes how to connect the TK-630, TK-730 and TK-830 transceivers to a personal computer using the KPG-4 programming interface cable.

1. Turn off the power to the computer. Refer to the operating manual of your computer for details on set-up.

2. Turn off the power to the transceiver.

3. Connect the 25-pin connector of the KPG-4 cable to the COM 1 or COM 2 port of your computer.
   If the COM 1 or COM 2 ports on your computer are 9-pin connectors, use a cable adapter to convert the 9-pin connector into a 25-pin connector, and then connect the KPG-4 to the computer via the adapter.

4. Connect the other end of the KPG-4 cable to the microphone connector of the transceiver.

5. Turn on the power to the computer.

6. Turn on the power to the transceiver while holding down KEY 1 and wait about two seconds.

7. The transceiver will enter the program mode at this point. If the transceiver header is a KCH-3, "PG" will be indicated on the LCD display panel. If the transceiver header is a KCH-4, "PROGRAM" will be indicated on the LCD display panel.

8. Start the KPG-7D program. Refer to the appropriate section of this manual for details on starting the program. When all read or write operations from or to the transceiver are terminated, a KCH-3-configured transceiver indicates this by displaying "EN" on the LCD display panel. A KCH-4-configured transceiver indicates this by displaying "END" on the LCD display panel.

9. Press KEY-2 to return the transceiver to the program mode. Both read and write operations can now be performed to and from the transceiver.

Figure 1-2 shows the set-up for running the program on an IBM PC.

Figure 1-2

![Diagram showing connection setup]
1-3 Installing the program

This section describes how to install the KPG-7D program from the original floppy disk to another floppy disk or to a hard disk.

● Installing onto a floppy disk

For this example we will assume that the current drive is drive C, and that the (original) KPG-7D floppy disk is inserted into drive A. The floppy disk onto which the KPG-7D program is to be installed is in drive B.

1 Change the current drive from drive C to drive A. When "C:¥ > " is displayed on the DOS screen, enter "A:" and press the Enter key. The current drive will change to drive A, and the DOS screen then displays "A:¥ > ".

2 Insert the floppy disk onto which you wish to install the KPG-7D program into drive B.

3 Enter "INSTALL B:" and press the Enter key. The KPG-7D program will now be installed onto the floppy disk in drive B. If the KPG-7D program disk is already in the current drive, Step 1 can be omitted. In that case, begin from Step 2.

● Installing onto a hard disk

For this example we will assume that the current drive is drive C and that the KPG-7D program disk is inserted in drive A.

1 Change the current drive from drive C to drive A. When "C:¥ > " is displayed on the DOS screen, enter "A:" and press the Enter key. The current drive will change to drive A, and the DOS screen then displays "A:¥ > ".

2 Enter "INSTALL C:" and press the Enter key. The KPG-7D program will now be installed onto the hard disk.
1-4 List of items included in this package

Instruction Manual (B62-0277-08) .................................................. 1
Program Disk 3.5" (720 K byte Format) ............................................ 1
Program Disk 5.25" (360 K byte Format) .......................................... 1

1-5 READ ME FILE

If revisions have been made to the program or if the descriptions in this manual are insufficient, a "READ ME FILE" is added to the program disk. The Read Me File contains descriptions of revisions which have been made or additional explanations. If there have been no changes, there may be no READ ME FILE on the floppy disk.

1-6 Applicable radio Models

○ RADIO MODEL
  TK - 530  TK - 730  TK - 830

○ CONTROL HEAD
  Basic Control Head (32ch, 39ch)
  Full Control Head (32ch, 160ch)

○ RADIO CONFIGURATION
  Single Control head + Single Band
  Dual Control head + Single Band
  Single Control head + Dual Band
2 Initial settings

Contents of this chapter

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-1 Starting the program</td>
<td>P8</td>
</tr>
<tr>
<td>2-2 Initial display</td>
<td>P9</td>
</tr>
<tr>
<td>2-3 Setting operational flow</td>
<td>P10~P11</td>
</tr>
<tr>
<td>2-4 Quitting the program</td>
<td>P11</td>
</tr>
</tbody>
</table>

2-1 Starting the program

This section explains what to do after you have connected the equipment and turned your computer on.

1. When you see the IBM-DOS screen displayed on your computer after power-up, insert the KPG-7D program floppy disk into the disk drive you wish to use.

2. For this example we will assume the current drive is drive C and that the KPG-7D floppy disk is inserted into drive A. You must change the current drive from drive C to drive A. When "C:~" is displayed on the DOS screen, enter "A:~", and press the Enter key. The current drive will change to drive A, and the DOS screen then displays "A:~".

   If the KPG-7D floppy disk is already in the current drive, Step 2 can be omitted. In that case, go directly from Step 1 to Step 3.

3. Enter "KPG7D", and press the Enter key.

4. The KPG-7D program starts up and the "LOADING PROGRAM, Please wait" message appears on the screen. Figure 2-1 shows the screen.

Figure 2-1

KPG-7D RADIO PROGRAMMING SOFTWARE
FOR TK-633 / 730 / 830 SERIES RADIO

VERSION 1.00
RELEASE 1/1/92

COPYRIGHT KENWOOD CORPORATION
1992 ALL RIGHT RESERVED

Hit any key to start.
2-2. Initial screen

This section describes the primary display, referred to as the initial screen. It is the first to appear after you have started the KPG-7D program as explained in Section 2-1.

1. While the screen shown in Figure 2-1 is displayed, press any key on the keyboard to display the screen shown in Figure 2-2.

Figure 2-2

<table>
<thead>
<tr>
<th>CH No.</th>
<th>Frequency</th>
<th>QT/DQT</th>
<th>SCN</th>
<th>OPT</th>
<th>DIA</th>
<th>SIG</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Receive</td>
<td>Transmit</td>
<td>Decode</td>
<td>Encode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* CHANNEL INFORMATION screen

Figures 2-2 and 2-3 show the screen which is used to specify settings and modes for the channels. In this manual, it is referred to as the CHANNEL INFORMATION screen. For details, see Chapter 4 CHANNEL INFORMATION screen.

* Menu

At the top of the screen there is a menu bar with the titles of the various menus available. The term "menu" as used in this manual refers to a title under which a number of the items required to perform the editing and processing of data and screens are grouped.

* Keys frequently used with the screens displayed by the KPG-7D program and their functions are described below.

- **Arrow keys**
  Moves the cursor to an item for making an entry.

- **Enter key**
  Executes the program and finalizes input data.

- **Alt key**
  Opens a menu window or returns to the previous screen.

- **Help key (F1 key)**
  Displays help messages. Pressing the F1 key will display the help message corresponding to the menu window that is open at the time.

- **F2 to F10 keys**
  Selects the functions assigned to those buttons as displayed in the various windows and screens.

- **PageUP/PageDN keys**
  Moves the Help Message display page forward or back one page at a time.

- **ESC key**
  Returns the program to the CHANNEL INFORMATION screen.
This section describes the operational flow of three typical setting operations using the KPG-7D program.

1. **Creating and writing new data to the transceiver:**

   - Specify the transceiver model type (Model).
   - Set the data (Edit/CHANNEL INFORMATION).
   - Write the data to the transceiver (Program/Write).
   - Save the data onto a disk (File/Save As).

2. **Modifying data previously written to the transceiver**

   - Read the data from the transceiver (Program/Read).
   - Modify the data (Edit/CHANNEL INFORMATION).
   - Write the data to the transceiver (Program/Write).
   - Save the data onto a disk (File/Save As).
Modifying data previously saved on a disk and writing them to the transceiver:

1. Read the data from a disk (File/Load).
2. Modify the data (Edit/CHANNEL INFORMATION).
3. Write the data to the transceiver (Program/Write).
4. Save the data onto a disk (File/Save As).

2.4 Quitting the program

This section describes how to quit the program.

1. Open the File menu window. (section 5.2)

2. Move the cursor to "Exit" with the up- or down-arrow key, and press the Enter key. You can also use the Quick Key for the selection. The window shown below then opens.

```
Return to DOS !
[ OK ]  [ CANCEL ]
```

3. Select either [OK] or [CANCEL] with the left- or right-arrow key or the Quick Key (section 3.1 or 3.2). If you select [OK], the program is shut down, and the operation returned to the DOS level command prompt. If you select [CANCEL], execution is cancelled, and the program returns to the previous screen.
3 Selecting and Inputting Data

This chapter describes how to select and input data using typical examples. There are four methods by which you can select or input data. Make sure you have a clear understanding of the procedures necessary to select and input data before attempting the actual settings. The information in parentheses following the description of each procedure refers to the section in which you can find an explanation of the selection or input method used for that procedure. For example, for CHANNEL INFORMATION SCAN, (section 3-1, or 3-2), directs you to see that section for the selection or input method required.

Contents of this chapter

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3-1</td>
<td>Using the arrow keys</td>
<td>P13</td>
</tr>
<tr>
<td>3-2</td>
<td>Using the Quick Key</td>
<td>P13</td>
</tr>
<tr>
<td>3-3</td>
<td>Inputting directly from the keyboard</td>
<td>P14</td>
</tr>
<tr>
<td>3-4</td>
<td>Selecting and inputting from the Directory</td>
<td>P15</td>
</tr>
</tbody>
</table>
3-1 Using the arrow keys

Here we use a typical example to explain this selection method. The method is similarly performed in other cases as well. When you see the display shown below, use the left- or right-arrow key to select either [OK] or [CANCEL].

<table>
<thead>
<tr>
<th>Load File Name</th>
<th>KPD-7D.B38</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ OK ]</td>
<td>[ CANCEL ]</td>
</tr>
</tbody>
</table>

1 Press the left- or right-arrow key to move the cursor to the item you wish to select, either [OK] or [CANCEL].

2 Press the Enter key.

3-2 Using the Quick Key

With a color monitor, Quick Key items are displayed in a different color from the other characters. (However, the Quick Key items may be indistinguishable in black & white. In that case, you must specify your selection using another method.)

Here we use a typical example to explain this selection method. The method is similarly performed in other cases as well. When you see the display shown below, press the Quick Key to select either [OK] or [CANCEL].

<table>
<thead>
<tr>
<th>Load File Name</th>
<th>KPD-7D.B38</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ OK ]</td>
<td>[ CANCEL ]</td>
</tr>
</tbody>
</table>

1 Press the Quick Key corresponding to the item you wish to select. Press the "O" key to select [OK]. Press the "C" key to select [CANCEL].
3-3. Inputting directly from the keyboard

Here we use a typical example to explain this selection method. The method is similarly performed in other cases as well.

① When you see the display shown below, enter the drive and the path name directly from the keyboard. The drive and path name displayed are the default names.

<table>
<thead>
<tr>
<th>Step</th>
<th>Drive &amp; Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>[ A:\KPG\D \DATA ]</td>
</tr>
</tbody>
</table>

1. Press the left-arrow key to move the cursor to the leftmost (heading) position where it blinks.
2. Press the Del key to delete the drive name and the path name that are already there.
3. Enter the new drive and path name in the correct sequence starting from the left using the alphanumeric keys on the keyboard.
4. Press the Enter key.

② When you see the display (CHANNEL INFORMATION screen) shown below, enter the Frequency Data directly from the keyboard.

<table>
<thead>
<tr>
<th>CH No</th>
<th>CH Name</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>GR1 CH1</td>
<td>450.0000</td>
</tr>
<tr>
<td>2</td>
<td>GR1 CH2</td>
<td>451.0000</td>
</tr>
</tbody>
</table>

1. Pressing the insert key causes the cursor to change from a - to a □ , and the background color of the entry area changes. (In black & white, the area is reverse-highlighted.)
2. Move the cursor to the position you wish to change using the arrow keys, and enter the desired character(s).
3. Press the Enter key.
3-4 Selecting and inputting from the Directory

When the Directory window, shown below, is displayed, press the up- or down-arrow key to select the desired file name from among those displayed. The file name is one example.

<table>
<thead>
<tr>
<th>Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>KPG-7D : B36</td>
</tr>
<tr>
<td>KPG-7D : B37</td>
</tr>
<tr>
<td>KPG-7D : B36</td>
</tr>
</tbody>
</table>

1. Press the up- or down-arrow key to move the cursor to the file name you wish to select. If there are more file names than can appear in the window, you can scroll undisplayed file names into the display window by holding down the down-arrow key.

2. Press the Enter key.
4 CHANNEL INFORMATION

Contents of this chapter

4-1 Overview ........................................ P16~P17
4-2 Setting the various items in the CHANNEL INFORMATION screen P18~P20

4-1 Overview

This section describes the CHANNEL INFORMATION. Figures 4-1, 4-2, and 4-3 show the CHANNEL INFORMATION screen. The CHANNEL INFORMATION screen is the one which is normally displayed when you are running the KPG-7D program and it is in this screen that settings such as CHANNEL are made. The methods for setting the various items are described in the following pages.

Figure 4-1

<table>
<thead>
<tr>
<th>File</th>
<th>Mode</th>
<th>Edlt</th>
<th>Program</th>
<th>Setup</th>
<th>F1 = Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic</td>
<td>32ch</td>
<td>Radio</td>
<td>UHF : 450-470</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Single</td>
<td>Head</td>
<td>Single Band</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Model : 836SS32B
File : KPG7D.B38

<table>
<thead>
<tr>
<th>CH</th>
<th>Frequency</th>
<th>QT/OQT</th>
<th>SCN</th>
<th>OPT</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
<td>Receive</td>
<td>Transmit</td>
<td>Decode</td>
<td>Encode</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

( Arrows: Move Enter: Input F1: Freq Cpy Alt: Goto Menu )
### Figure 4-2

<table>
<thead>
<tr>
<th>CH No</th>
<th>Name</th>
<th>Frequency (MHz)</th>
<th>GT/DTQ</th>
<th>SCN</th>
<th>OPT</th>
<th>Scrambler</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>450.000000</td>
<td>455.000000</td>
<td>67.0</td>
<td>67.0</td>
<td>Add</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>451.000000</td>
<td>456.000000</td>
<td>100.0</td>
<td>100.0</td>
<td>Add</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>150.000000</td>
<td>150.000000D134N</td>
<td>D134N</td>
<td>D134N</td>
<td>Add</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>150.000000</td>
<td>160.000000D4111</td>
<td>D4111</td>
<td>D4111</td>
<td>Add</td>
</tr>
</tbody>
</table>

F3: Ch Cpy  F10: Pri Ch Set  Alt: Goto Menu

### Figure 4-3

<table>
<thead>
<tr>
<th>CH No</th>
<th>Name</th>
<th>Frequency (MHz)</th>
<th>GT/DTQ</th>
<th>SCN</th>
<th>OPT</th>
<th>Scrambler</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>GR 1</td>
<td>CH 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>GR 1</td>
<td>CH 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>GR 1</td>
<td>CH 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>GR 1</td>
<td>CH 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>GR 1</td>
<td>CH 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>GR 1</td>
<td>CH 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>GR 1</td>
<td>CH 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>GR 1</td>
<td>CH 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>GR 1</td>
<td>CH 9</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>GR 1</td>
<td>CH 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>GR 1</td>
<td>CH 11</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>GR 1</td>
<td>CH 12</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>GR 1</td>
<td>CH 13</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>GR 1</td>
<td>CH 14</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>GR 1</td>
<td>CH 15</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>GR 1</td>
<td>CH 16</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

GRP: 1  Group: Del/Add: [Del]  F3: Ch Cpy  F7: Next  F8: Prev  Alt: Goto Menu
4-2 Setting the various items on the CHANNEL INFORMATION screen

Move the cursor to the channel and item you wish to set. If you have configured channels into groups, use the F7 and F8 keys to select the group you wish to set before moving the cursor. When the setting is completed, the cursor moves to the next item. (If a settings window is open, close it first.)

- Priority Channel indication
  If you set Priority 1 or 2 as either "Fixed" or "Operator Selectable" in the Scan Information window in the edit menu, pressing the "F10" key: Priority Set displays "1" or "2" at the left of the channel number of the relevant channel(s) depending on whether the channels are set as Priority 1 or Priority 2.

- Channel Name
  By adding the KCH-5 option to a basic control head package, you can have two alphanumeric characters for the channel name. By adding it to a full control head package, you can have twelve alphanumeric characters. You can enter an easy-to-understand name for each channel and display the names for the channels instead of their numbers.
  1. Enter the desired channel name directly from the keyboard.
  2. Press the Enter key.

- Frequency (Receive /Transmit)
  1. Enter values for the Receive Frequency and the Transmit Frequency within the band setting range directly from the keyboard.
  2. Press the Enter key.

- Signaling Q/T DQT (Decode /Encode)
  You can enter the values for Q/T/DQT Decode/Encode directly from the keyboard or you can press the F2 key and select a setting from the chart which is thereby displayed. If you are selecting DQT, enter a "D" before the DQT DATA entered, and an "N" or an "I" after. For example, if you wish to specify DQT DATA 777 NORMAL, enter "D777N". If you wish to use DQT DATA 555 INVERSE, enter "D555I". ("N" need not be typed in the case the setting is "NORMAL". The KPG-7D program will automatically put "N" in the proper location.)
  1. Enter Q/T/DQT DATA directly from the keyboard
     (or Press F2 Key to display the Q/T/DQT chart. Make your selection by moving the cursor to the Q/T/DQT value you wish to use.)
  2. Press the Enter key.

- SCAN (DELETE /ADD)
  When you enter the Receive Frequency, "Add" is set as the default. The option you specify here simply becomes the preset value for D/A under the Key Selection menu item. The user-specified value for the D/A key takes precedence over the default value. If you do not set the D/A key, this value remains fixed.
  1. Press the Enter key to open the settings window.
  2. Select [Delete] or [ADD] with the arrow key(s) or the Quick Key (section 3-1 or 3-2).
     (or You can alternately between the [Delete] and [ADD] selections by pressing either the F2 key or the space bar. Select either [Delete] or [ADD], and press the Enter key.)
Option Signaling

You can enable and disable the signaling unit option on a per-channel basis. By specifying [yes] for this item, squelch is controlled by the option signaling unit.

1. Press the Enter key to open the settings window.

2. Select either [Yes] or [No] using the arrow keys or the Quick Key (section 3-1, or 3-2).
   (or You can alternate between the [Yes] and [No] selections by pressing either the F2 key or the space bar. Select either [Yes] or [No], and press the Enter key.)

Scrambler

This is displayed only when you have selected "Installed....Yes" when specifying the model type. You can enable and disable the scrambler option for each channel. The default setting is "No".

1. Press the Enter key to open the settings window.

2. Select either [Yes] or [No] with the arrow keys or the Quick Key (section 3-1, or 3-2).
   (or You can alternate between the [Yes] and [No] selections by pressing either the F2 key or the space bar. Select either [Yes] or [No], and press the enter key.)

Scrambler Code

This is displayed only when you have selected "Installed....Yes" when specifying the transceiver model type. There are sixteen codes (1 to 16) from which a selection can be made for each channel.

1. Enter the desired scrambler code directly from the keyboard.
   (or Select a code number from 1 to 16 using the F2 key.)

2. Press the Enter key.

IF Frequency < Shift + F6 : IF / STEP >

The IF frequency should be set only in the case of special specifications. Normally, it should be left at the default setting.

1. Press the Shift + F6 key to open the settings window. Move the cursor to "IF frequency".

2. Enter the desired IF frequency directly from the keyboard.

3. Press the Enter key.

4. Press the Alt key to open the confirmation window. Select [OK] to confirm the setting or select [Cancel] to cancel the setting.

5. Press the Enter key.

Frequency Step < Shift + F6 : IF / STEP >

The frequency step should be set only in the case of special specifications. The frequency step is determined for each band by the FCC, so do not change it. However, it can be switched in some bands. For example, the 10 kHz ~ 12.5 kHz band or the 5 kHz ~ 6.25 kHz band.

1. Press the Shift + F6 key to open the settings window. Move the cursor to "Frequency Step".

2. Press the Enter key. A second settings window now opens.

3. Select the desired Frequency Step with the arrow keys or the Quick Key (section 3-1, or 3-2).

4. Press the Alt key to open the confirmation window. Select [OK] to confirm the setting or select [Cancel] to cancel the setting.

5. Press the Enter key.
● Priority Set  < F10 : Priority Set >
  If you set Priority 1 CH or Priority 2 CH to either "Fixed" or "Operator Selectable" in the Scan Information display, <F10:Priority Set> will appear in the Key menu at the bottom of the display to enable channel setting.

1 Press the F10 key to open the settings window. If you have set both Priority 1 Channel and Priority 2 Channel to either "Fixed" or "Operator Selectable", both Priority 1 and Priority 2 will appear in the settings window. If you have set only one of them to "Fixed" or "Operator Selectable", then only that one will appear in the settings window.

2 Select the desired priority channel with the arrow keys (section 3-1).

※ The operation of other keys

● Control [ Ctrl ] Key
  The statuses of Priority 1 and 2, and the assignments of the OPT and Aux keys are displayed for your information.

● Shift + F3
  Group Copy (full-featured model only): Copies channel data from one group to another group.

1 The settings window opens.

2 The group given in the window is the source group. From the keyboard, directly enter the number of the group you wish to copy to.

3 Press the Enter key to execute. Press the Alt key if you wish to abort the process.

● Shift + F4
  QT/QT Copy: Copies the decode tone (QT/DQT) of the channel the cursor is positioned at to the encode tone.

1 The settings window opens.

2 Press the Enter key to execute. Press the Alt key if you wish to abort the process.

● Shift + F9
  Channel Insert: Inserts a new channel to the channel location where the cursor is currently positioned. The channels after the new position all shift back one position. However, you cannot insert new channel(s) if there are data set to the last channel (either channel 32 or channel 99 on the basic model, and channel 16 of the group currently being displayed on the full featured model).

● Shift + F10
  Channel delete: Deletes the channel where the cursor is positioned. The channels after the deleted channel all move up one position in order.

● HOME
  The cursor jumps to the channel 1 position (group 1 channel 1 in the full featured model).

● END
  The cursor jumps to the last channel (either channel 32 or channel 99 on the basic model, and channel 16 of either group 2 or group 10 on the full featured model).
5 Menu

Contents of this chapter

| 5-1 Overview .................................................. P21 |
| 5-2 Opening the menu windows ................................. P22 |

5-1 Overview

The term "menu" as used in this manual refers to the file under which the items required to edit and set the processing of data and screens are grouped. The menus include File, Model, Edit, Program, Setup, and F1 = Help. The menu bar shown below is displayed at the top of the screen.

| File | Model | Edit | Program | Setup | F1 = Help |

Below are brief descriptions of the functions of the various menus.

● File
  The File menu allows you to create, save, open, delete, and print data files residing on a disk, as well as exit the program or the operations of the current screen.

● Model
  The Model menu allows you to set the model type of the transceiver you will be writing data to.

● Edit
  The Edit menu allows you to edit all data other than channel information.

● Program
  The Program menu allows you to write data to and read data from the EEPROM (memory) in the transceiver.

● Setup
  The Setup menu allows you to set the port to which you wish to connect the KPG-7D programming interface cable, the color of the display, and the drive and path name of the Help file.

● F1 = Help
  The F1 = Help menu displays help messages.
5-2 Opening the menu windows

This section describes the keyboard operations by which you can display the "frames" of the various menus which contain the lists of commands for setting and selecting data. In this manual these frames are referred to as "windows", and displaying one of these frames is "opening a menu window". Making a frame disappear is "closing a menu window". The information in parenthesis (section: 5 - 2) of each procedure refers to this section in which you can open the menu window.

1 Press the Alt key with the CHANNEL INFORMATION screen displayed on your monitor. However, if any window other than one of the menu windows is open, press the ESC key first to exit that window before pressing the Alt key.

2 The "File menu window" shown in Figure 5-2 opens under the File menu. If you press the Alt key again while the file menu window is open, it closes. Each time you press the Alt key, the window alternately opens and closes.

![Menu Window Diagram]

Figure 5-2

3 If you press the right- or left-arrow key while the File menu window is open as shown in Figure 5-2, the menu windows under the various menu titles will open as you move the cursor along the menu bar. However, only the menu window directly below the cursor is open at any one time; all other windows are closed. The windows for all the menus are shown below.

![Menu Window Diagram]
6 File

The File menu allows you to create, save, open, delete, and print data files residing on a disk, as well as exit the program.

Contents of this chapter

| 6-1 New | ................................................. P23 |
| 6-2 Load | ................................................. P24 |
| 6-3 Save | ................................................. P25 |
| 6-4 Save As | ................................................. P26 |
| 6-5 Delete | ................................................. P27 |
| 6-6 Print | ................................................. P28 |
| 6-7 Exit | ................................................. P28 |

6-1 New

The New function clears the data file already created and allows you to create a new file. This operation sets all data to their initial values.

1. Open the File menu window. (section 5-2)

2. Move the cursor to "New" with the up- or down-arrow key, and press the Enter key. You can also use the Quick Key for the selection. The window shown below then opens.

   WARNING !
   ALL DATA will be cleared.

   [ OK ] [ CANCEL ]

3. Select either [OK] or [CANCEL] with the left- or right-arrow key or the Quick Key (section 3-1., or 3-2). If you select [OK], all data settings are reset to their initial values and the program returns to the CHANNEL INFORMATION screen. If you select [CANCEL], execution is cancelled, and the program returns to the previous screen.
6-2 Load

The Load function reads transceiver data files previously saved on a hard disk or a floppy disk and writes them into the buffer memory of your computer.

1. Open the File menu window. (section 5-2)

2. Move the cursor to "Load" with the up- or down-arrow key, and press the Enter key. You can also use the Quick Key for the selection. A window opens displaying the drive and path name of the file currently loaded, as shown below.

   Drive & Path: A:\KPG7D\DATA

3. Enter the drive and path name of the desired file directly from the keyboard (section 3-3). The window shown below then opens. This window displays the name(s) of the file(s) on that path. The file name is one example. (Note: * Expansion element)

   Directory
   - KPG-7D.B38
   - KPG-7D.B37
   - KPG-7D.B36

4. Select the desired file name with the up- or down-arrow key. (section 3-4) The window shown below then opens.

   Load File Name: KPD-7D.B38
   [ OK ] [ CANCEL ]

5. Select either [OK] or [CANCEL] with the right/left arrow keys or the Quick Key (section 3-1 or 3-2). If you select [OK], the file is loaded and the program returns to the CHANNEL INFORMATION screen. If you select [CANCEL], execution is cancelled, and the program returns to the previous screen.

Note: * Expansion element

Expansion element

**********, B 3 8

- File Name
- Radio 1 Band
  6: VHF LOW
  7: VHF HIGH
  8: UHF
- Channel number
  3: 32 ch
  0: 98 ch
  1: 160 ch
- Control Head Type
  B: Basic Control Head
  A: Basic + Alphanumeric
  F: Full Control Head
6-3 SAVE

The Save function saves the data file you have created to the data file name at the current drive and path name. This method permits you to omit selecting the file name input type and the drive and path name of the data file.

1. Open the File menu window. (section 5-2)

2. Move the cursor to "Save" with the up- or down-arrow key, and press the Enter key. You can also use the Quick Key for the selection. The window shown below then opens. This window displays the drive and path name of the file currently loaded.

   Save File Name : SAMPLE.B38
   [ OK ] [ CANCEL ]

3. Select either [OK] or [CANCEL] with the left- or right-arrow key or the Quick Key (section 3-1 or 3-2). If you select [OK], the data is saved and the program returns to the CHANNEL INFORMATION screen. If you select [CANCEL], execution is cancelled, and the program returns to the previous screen.
6-4  SAVE AS

The Save As function saves the data file you have created onto a specified disk. You must specify the drive and path in this case. If the drive and path are not specified, an error occurs. To prevent this, create a drive and path name to a data file disk in advance.

1  Open the File menu window.  (section 5-2)

2  Move the cursor to "Save As" with the up- or down-arrow key, and press the Enter key. You can also use the Quick Key for the selection. The window shown below then opens. The drive and path name displayed in this window is the default path.

<table>
<thead>
<tr>
<th>Setup Drive &amp; Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ A:\KPG7D\DATA ]</td>
</tr>
</tbody>
</table>

3  Enter the desired drive and path name directly from the keyboard (section 3-3). The window shown below then opens. The file name appearing in this window is the default file name.

<table>
<thead>
<tr>
<th>Save File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ SAMPLE ]</td>
</tr>
</tbody>
</table>

4  Enter the desired file name directly from the keyboard (section 3-3). Or press the F9 key to open the Directory window. You can then select the file name from the Directory window. (section 3-4)

   | Save File Name : SAMPLE.B33 |
   | [ OK ]    [ CANCEL ] |

5  Select either [OK] or [CANCEL] with the left- or right-arrow key or the Quick Key (section 3-1 or 3-2). If you select [OK], the data is saved and the program returns to the CHANNEL INFORMATION screen. If you select [CANCEL], execution is cancelled, and the program returns to the previous screen.
6-5 Delete

The Delete function deletes a data file which has been already created. This allows you to delete unneeded data files from a specified disk so that you can ensure sufficient disk space and eliminate waste.

1. Open the File menu window. (section 5-2)

2. Move the cursor to "Delete" with the up- or down-arrow key, and press the Enter key. You can also use the Quick Key for the selection. The window shown below then opens. The drive and path name displayed in this window is the default path.

```
<table>
<thead>
<tr>
<th>Setup Drive &amp; Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ A:\KPG7D\DATA ]</td>
</tr>
</tbody>
</table>
```

3. Enter the desired drive and path name directly from the keyboard (section 3-3). The Directory window shown below opens. The file names shown here are only examples.

```
<table>
<thead>
<tr>
<th>Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>KPG7D.B36</td>
</tr>
<tr>
<td>KPG7D.B37</td>
</tr>
<tr>
<td>KPG7D.B38</td>
</tr>
</tbody>
</table>
```

4. Select a file name (section 3-4). The window shown below then opens.

```
<table>
<thead>
<tr>
<th>Delete File Name:</th>
<th>KPG7D.B38</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ OK ]</td>
<td>[ CANCEL ]</td>
</tr>
</tbody>
</table>
```

5. Select either [OK] or [CANCEL] with the left- or right-arrow key or the Quick Key (section 3-1 or 3-2). If you select [OK], the file is deleted and the program returns to the CHANNEL INFORMATION screen. If you select [CANCEL], execution is cancelled, and the program returns to the previous screen.
6-6 Print

The Print function outputs data you have created, data from a data file disk you have loaded or data read from the transceiver to the printer and prints them out. You can print out as follows.

- Model Type
- File Name
- Embedded Message
- Model Type Configuration
- Key Selection
- Scan Information
- Feature Option
- Frequency Step
- Other Information
- Channel Information

1. Open the File menu window. (section 5-2)

2. Move the cursor to "Print" with the up- or down-arrow key, and press the Enter key. You can also use the Quick Key for the selection. The window shown below then opens.

   ![Print Window]

   Edit Data Print Out.
   [ OK ] [ CANCEL ]

3. Select either [OK] or [CANCEL] with the left- or right-arrow key or the Quick Key (section 3-1 or 3-2). If you select [OK], the data are printed and the program returns to the CHANNEL INFORMATION screen. If you select [CANCEL], execution is cancelled, and the program returns to the previous screen.

6-7 Exit

The Exit function shuts down the KPG-7D program and returns you to the DOS level.

1. Open the File menu window. (section 5-2)

2. Move the cursor to "Exit" with the up- or down-arrow key, and press the Enter key. You can also use the Quick Key for the selection. The window shown below then opens.

   ![Exit Window]

   Return to DOS 1
   [ OK ] [ CANCEL ]

3. Select either [OK] or [CANCEL] with the left- or right-arrow key or the Quick Key (section 3-1 or 3-2). If you select [OK], the program is shut down, and the operation returned to the DOS level command prompt. If you select [CANCEL], execution is cancelled, and the program returns to the previous screen.
7 Model

Contents of this chapter

<table>
<thead>
<tr>
<th>7-1 Overview</th>
<th>P29~P30</th>
</tr>
</thead>
<tbody>
<tr>
<td>7-2 Model type settings</td>
<td>P31~P36</td>
</tr>
</tbody>
</table>

7-1 Overview

The Model menu is the menu used to set the transceiver model type. Because the items to be set under the Edit menu depend on the transceiver model type, you must first set the model type when creating a new data file. Model type settings consist of "Control Head Type", "Radio Configuration", and "Radio Band: Single or Dual". Each setting is described below.

Control Head Type

There are five types of Control Heads, as listed below. The manner in which they are displayed in the Model menu window are as shown at the right of the arrows below.

- Basic Control Head
- Basic Control Head + KCH-5/2
- Basic Control Head + KCH-5/2 (32ch Alphanumeric)
- Basic Control Head + KCH-5 (32ch Alphanumeric)
- Full Featured Control Head
- Full Featured Control Head + KCH-5 (32ch Alphanumeric)
- Full Featured Control Head + KCH-5 (160ch Alphanumeric)

In addition, there are options for the control heads as outlined below.

- KCH-3 Basic Front Panel Kit
  The basic model is equipped with this type of control head. It is required when you configure your model as a dual control head, but you do not select KCH-4 from within the program.

- KCH-4 Full Featured Front Panel Kit
  The full-featured model is equipped with this type of control head. It is required when you configure your model as a dual control head, but you do not select KCH-5 from within the program.

- KCH-5 Channel Expansion Kit
  This is a channel expansion kit for both the basic model and the full-featured model. You use this kit to expand the basic model from 32 channels to 99 channels, and the full featured model from 32 channels to 160 channels. The KCH-5 EEPROM, added to the head of the basic model, allows you to display channel names using alphanumeric characters.

Radio Configuration

There are three types of Radio Configuration as follows.

- Single Control Head, Single Band
- Dual Control Head, Single Band
- Single Control Head, Dual Band
Radio Band

The range of frequencies differs according to the model type. The available bands are listed in the following table.

<table>
<thead>
<tr>
<th>Model Type</th>
<th>Frequency Band</th>
<th>Frequency Range (MHz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>TK-630</td>
<td>VHF LOW</td>
<td>F1: 28.7~37&lt;br&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>F2: 35~43&lt;br&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>F3: 41~50&lt;br&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Special Tune: 29.7~50</td>
</tr>
<tr>
<td>TK-730</td>
<td>VHF HIGH</td>
<td>F1: 150~174&lt;br&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>F2: 136~156&lt;br&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Special Tune: 136~174</td>
</tr>
<tr>
<td>TK-830</td>
<td>UHF</td>
<td>F1: 450~470&lt;br&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>F2: 470~490&lt;br&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>F3: 490~512&lt;br&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>F4: 403~430&lt;br&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Special Tune: 400~520</td>
</tr>
</tbody>
</table>
7-2 Model type settings

Descriptions are given for the following three radio configurations:
- Single Control Head + Single Band
- Single Control Head + Dual Band
- Dual Control Head + Single Band

Single Control Head + Single Band

1. Open the Model menu window (section 5-2)

2. Select the control head type with the up- or down-arrow key or the Quick Key (section 3-1 or 3-2). The window shown below then opens.

<table>
<thead>
<tr>
<th>Control Head</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Control Head</td>
</tr>
<tr>
<td>Dual Control Head</td>
</tr>
</tbody>
</table>

3. Select "Single Control Head" with the up- or down-arrow key or the Quick Key (section 3-1 or 3-2). The window shown below then opens.

<table>
<thead>
<tr>
<th>Band</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Band</td>
</tr>
<tr>
<td>Dual Band</td>
</tr>
</tbody>
</table>

4. Select "Single Band" with the up- or down-arrow key or the Quick Key (section 3-1 or 3-2). The window shown below then opens.

<table>
<thead>
<tr>
<th>Radio Band</th>
</tr>
</thead>
<tbody>
<tr>
<td>UHF</td>
</tr>
<tr>
<td>VHF Hi</td>
</tr>
<tr>
<td>VHF Low</td>
</tr>
</tbody>
</table>
5. Select the radio band with the up- or down-arrow key or the Quick Key (section 3-1 or 3-2). Depending on your selection, one of three windows corresponding to the choice of radio band you made then opens. These windows are shown below as A, B, and C.

![Radio Band Selection](image)

6. Select the desired frequency range with the up- or down-arrow key or the Quick Key (section 3-1 or 3-2). The window shown below then opens.

![Frequency Range Selection](image)

7. Select whether or not a voice scrambler unit is installed in Radio 1. Select [Yes] or [No] with the left- or right-arrow key or the Quick Key (section 3-1 or 3-2). The window shown below then opens. The window shown below assumes that you selected UHF 470-490.

![Voice Scrambler Unit](image)

8. Select [OK] or [CANCEL] with the left- or right-arrow key or the Quick Key (section 3-1 or 3-2). If you select [OK], the model type is set as shown in the above window, and the program returns to the CHANNEL INFORMATION screen. If you select [CANCEL], execution is cancelled and the program returns to the previous screen.
Single Control Head + Dual Band

1. Open the Model menu window (section 5-2).

2. Select the control head type with the up- or down-arrow key or the Quick Key (section 3-1 or 3-2). The window shown below then opens.

   Control Head
   Single Control Head
   Dual Control Head

3. Select "Single Control Head" with the up- or down-arrow key or the Quick Key (section 3-1 or 3-2). The window shown below then opens.

   Band
   Single Band
   Dual Band

4. Select "Dual Band" with the up- or down-arrow key or the Quick Key (section 3-1 or 3-2). The window shown below then opens.

   Radio 1   Band
   UHF
   VHF Hi
   VHF Low

   Radio 2   Band
   UHF
   VHF Hi
   VHF Low

5. Select a radio band for the Radio 1 band with the up- or down-arrow key or the Quick Key (section 3-1 or 3-2). Depending on your selection, one of three windows corresponding to the choice of radio band you made for the Radio 1 band then opens. These windows are shown below as A, B, and C.

   A
   UHF
   1: 450 - 470
   2: 470 - 490
   3: 490 - 512
   4: 500 - 530
   5: SP Tune

   B
   VHF HIGH
   1: 150 - 174
   2: 176 - 198
   3: SP Tune

   C
   VHF LOW
   1: 267 - 287
   2: 305 - 325
   3: 343 - 363
   4: SP Tune
6 Select the desired frequency range with the up- or down-arrow key or the Quick Key (section 3-1 or 3-2). The window shown below then opens.

<table>
<thead>
<tr>
<th>Radio 1 Band</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>UHF</td>
<td></td>
</tr>
<tr>
<td>VHF Hi</td>
<td></td>
</tr>
<tr>
<td>VHF Low</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Radio 2 Band</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>UHF</td>
<td></td>
</tr>
<tr>
<td>VHF Hi</td>
<td></td>
</tr>
<tr>
<td>VHF Low</td>
<td></td>
</tr>
</tbody>
</table>

7 Select a radio band for the Radio 2 band with the up- or down-arrow key or the Quick Key (section 3-1 or 3-2). Depending on your selection, one of three windows corresponding to the choice of radio band you made for the Radio 2 band then opens. These windows are shown below as A, B, and C.

![Diagram](image)

8 Select a frequency range with the up- or down-arrow key or the Quick Key (section 3-1 or 3-2). The window shown below then opens.

Is a VOICE SCRAMBLER UNIT installed in this Radio (Deck)?

- e.g. SC - 2460

[ Yes ] [ No ]
9 Select whether or not a voice scrambler unit is installed in Radio 1. Select [Yes] or [No] with the left- or right-arrow key or the Quick Key (section 3-1 or 3-2). The window shown below then opens. The window shown below assumes that you selected UHF: 490-512 for the Radio 1 band, and VHF HIGH: 150-174 for the Radio 2 band.

<table>
<thead>
<tr>
<th>Model</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic</td>
<td></td>
</tr>
<tr>
<td>32 ch</td>
<td></td>
</tr>
<tr>
<td>Single</td>
<td>Head</td>
</tr>
<tr>
<td>Dual</td>
<td>Band</td>
</tr>
</tbody>
</table>

Radio 1 Band | UHF 490-512
Radio 2 Band | VHF HIGH 150-174
[ OK ] [ Cancel ]

10 Select [OK] or [CANCEL] with the left- or right-arrow key or the Quick Key (section 3-1 or 3-2). If you select [OK], the system is set as shown in the above window, and the program returns to the CHANNEL INFORMATION screen. If you select [CANCEL], execution is cancelled and the program returns to the previous screen.

○ Dual Control Head + Single Band

1 Open the Model menu window (section 5-2)

2 Select the control head type with the up- or down-arrow key or the Quick Key (section 3-1 or 3-2). The window shown below then opens.

<table>
<thead>
<tr>
<th>Control Head</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Control Head</td>
</tr>
<tr>
<td>Dual Control Head</td>
</tr>
</tbody>
</table>

3 Select “Dual Control Head” with the up- or down-arrow key or the Quick Key (section 3-1 or 3-2). The window shown below then opens.

<table>
<thead>
<tr>
<th>Radio Band</th>
</tr>
</thead>
<tbody>
<tr>
<td>UHF</td>
</tr>
<tr>
<td>VHF Hi</td>
</tr>
<tr>
<td>VHF Low</td>
</tr>
</tbody>
</table>
4 Select the radio band used with the up- or down-arrow key or the Quick Key (section 3-1 or 3-2). Depending on your selection, one of three windows corresponding to the choice of radio band you made then opens. These windows are shown below as A, B, and C.

A

<table>
<thead>
<tr>
<th>UHF</th>
</tr>
</thead>
<tbody>
<tr>
<td>1: 450 - 470</td>
</tr>
<tr>
<td>2: 470 - 490</td>
</tr>
<tr>
<td>3: 490 - 512</td>
</tr>
<tr>
<td>4: 400 - 430</td>
</tr>
<tr>
<td>5: SP Tune</td>
</tr>
</tbody>
</table>

B

<table>
<thead>
<tr>
<th>VHF HIGH</th>
</tr>
</thead>
<tbody>
<tr>
<td>1: 150 - 174</td>
</tr>
<tr>
<td>2: 196 - 198</td>
</tr>
<tr>
<td>3: SP Tune</td>
</tr>
</tbody>
</table>

C

<table>
<thead>
<tr>
<th>VHF LOWW</th>
</tr>
</thead>
<tbody>
<tr>
<td>1: 29.7 - 37</td>
</tr>
<tr>
<td>2: 35 - 43</td>
</tr>
<tr>
<td>3: 41 - 50</td>
</tr>
<tr>
<td>4: SP Tune</td>
</tr>
</tbody>
</table>

5 Select the frequency range with the up- or down-arrow key or the Quick Key (section 3-1 or 3-2). The window shown below then opens.

Is a VOICE SCRAMBLER UNIT installed in this Radio ( Desk ) ?

(e.g. SC - 2450 )

[ Yes ] [ No ]

6 Select whether or not a voice scrambler unit is installed in Radio 1. Select [Yes] or [No] with the left- or right-arrow key or the Quick Key (section 3-1 or 3-2). The window shown below then opens. The window shown below assumes that you selected UHF: 400-430.

Model Type

<table>
<thead>
<tr>
<th>Basic 32 ch</th>
<th>Single Band</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radio Band</td>
<td>UHF : 400 - 430</td>
</tr>
</tbody>
</table>

[ OK ] [ Cancel ]

7 Select [OK] or [CANCEL] with the left- or right-arrow key or the Quick Key (section 3-1 or 3-2). If you select [OK], the system is set as shown in the above window, and the program returns to the CHANNEL INFORMATION screen. If you select [CANCEL], execution is cancelled and the program returns to the previous screen.
8 Edit

Contents of this chapter

8-1 Overview .................................................. P37~P43
8-2 Key Selection .............................................. P44~P45
8-3 Scan Information ......................................... P46~P47
8-4 Feature Option ............................................. P48~P50

8-1 Overview

The Edit menu allows you to create various types of transceiver data. The Edit menu consists of "Key Selection", "Scan Information", "Feature Option" and "Embedded Message". Each is described separately in this chapter.

Key Selection
Assigns a function to each of the keys on the front panel of the basic control head or the full control head.

Basic Control Head
Shown below in the middle of the display is a representation of the basic control head front panel. The functions which can be assigned to the MON, SCN, OPT, and D/A keys are listed in the Key Selection window shown in Figure 6.

![Diagram of Basic Control Head](image-url)

(Arrows: Move, Space: Select, F10: OPT, Aux sel, Alt: Abort, ESC: Return to Edit)
Full Control Head

Full Control Head: Shown below in the middle of the display is a representation of the full control head front panel. The functions which can be assigned to MON, SCN, KEY 1, KEY 2, KEY 3 and KEY 4 on the front panel are listed in the Key Selection window shown in Figure 8.

Figure 8

<table>
<thead>
<tr>
<th>Key Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>space</td>
</tr>
<tr>
<td>Mon</td>
</tr>
<tr>
<td>scN</td>
</tr>
<tr>
<td>Pa</td>
</tr>
<tr>
<td>Ha</td>
</tr>
<tr>
<td>Ta</td>
</tr>
<tr>
<td>ic</td>
</tr>
<tr>
<td>Am</td>
</tr>
<tr>
<td>Sp</td>
</tr>
<tr>
<td>D/a</td>
</tr>
<tr>
<td>Opt</td>
</tr>
<tr>
<td>auX</td>
</tr>
</tbody>
</table>

See "* Key function descriptions" following this page for a description of the functions of each of the key listings.
Key function descriptions

- **Space**: Not Used
  If you select "Not used", the function of the specified key is disabled.

- **Mon**: Monitor
  The assigned key becomes the Monitor switch. (This key is preassigned.)

- **ScrN**: Scan
  The assigned key becomes the Scan switch. (This key is preassigned.)

- **Pa**: Public Address
  Outputs audio from MIC to the external speakers.

- **Ha**: Horn Alert
  Sounds the horn when you have decoded other signaling.

- **IC**: Intercom
  Works only with the dual control head configuration. Outputs voice from the other control head speaker when you press the PTT switch and speak.

- **Ta**: Talk Around

- **Alphanumeric**: In the case of the basic control head configuration, works only when the KCH-5 option has been installed. Switches the display between the CH display and a display of programmed alphanumeric characters.

- **D/A**: Delete/Add
  Switches between Delete and Add for scanning. If you do not select this key, Delete/Add is set to the value you have selected in the CHANNEL INFORMATION screen.

- **Opt**: Voice Scrambler
  Used to control signaling options and so forth. Designed to be used for a voice scrambler.

  - **Operator Selectable Tone (QT/DQT)**
    The tone set with the Feature Option.

  - **Auxiliary**
    Controls the auxiliary switch.

- **auX**: Voice Scrambler
  Used to control signaling options and so forth. Designed to be used for a voice scrambler.

  - **Operator Selectable Tone (QT/DQT)**
    The tone set with the Feature Option.

  - **Auxiliary**
    Controls the auxiliary switch.

**Note**: The OPT key and the Aux key can each have three functions assigned to them. However, you cannot assign the same functions to both of the keys concurrently. It will be easier to keep track of the key functions if you assign names to the control head keys with the KCH-6 option, which has the various functions printed.
For Scan Information:

Scan Information allows you to set up the following settings for Priority 1, Priority 2, Group Scan, Resume Time, Look Back Time A, Look Back Time B, and Revert Channel. This section describes each of these setting items separately.

- **PRIORITY SCAN** (Priority 1, Priority 2)
  - Set one of four selections: NONE, FIXED, SELECTED CHANNEL, or OPERATOR SELECTABLE.
  - These items have the following meanings as described in the table below when set for PRIORITY CHANNEL.

<table>
<thead>
<tr>
<th></th>
<th>NONE</th>
<th>FIXED</th>
<th>SELECTED CHANNEL</th>
<th>OPERATOR SELECTABLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRIORITY 1 CH</td>
<td>Both Priority 1 CH and Priority 2 CH are set to &quot;None&quot;, and Priority Scan is invalidated.</td>
<td>Sets the Priority 1 CH. This channel must be set to RX FREQUENCY.</td>
<td>Sets the channel selected with the channel knob to PRIORITY 1 CH before the scanning operation.</td>
<td>Allows you to set PRIORITY 1 CH with a control head key.</td>
</tr>
<tr>
<td>PRIORITY 2 CH</td>
<td>Eliminates PRIORITY 2 CH and performs a Single Priority Scan of PRIORITY 1 CH only.</td>
<td>Sets the PRIORITY 2 CH. This channel must be set to RX FREQUENCY.</td>
<td>Sets the channel selected with the channel knob to PRIORITY 2 CH before the scanning operation.</td>
<td>Allows you to select PRIORITY 2 CH with a control head key.</td>
</tr>
</tbody>
</table>

The relationship between status combinations of Priority 1 and Priority 2 and Revert CH is described below. The KPG-7D automatically determines the selection range. Refer to the table and descriptions below for details.

There are twelve combinations you can select from for Priority 1 and Priority 2. The table 8-1 shows these twelve combinations and the designations for the revert channel assignment which is designated for the combination you select. There are a total of fifteen revert channels you can assign. You can select one revert channel for each of the combinations shown in the table. The table lists the fifteen designations for the fifteen revert channel assignments that you can select. For the meanings of the different number designations, see "Revert Channel assignments".

40
### Table 8-1

<table>
<thead>
<tr>
<th>Pattern</th>
<th>PRIORITY 1 CHANNEL</th>
<th>PRIORITY 2 CHANNEL</th>
<th>REVERT CHANNEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FIXED</td>
<td>NONE</td>
<td>①,②,③,④,⑤</td>
</tr>
<tr>
<td>2</td>
<td>FIXED</td>
<td>FIXED</td>
<td>①,②,③,④,⑤</td>
</tr>
<tr>
<td>3</td>
<td>FIXED</td>
<td>OPERATOR SELECTABLE</td>
<td>①,②,④,⑤,⑥,⑦,⑧,⑨</td>
</tr>
<tr>
<td>4</td>
<td>FIXED</td>
<td>SELECTED CHANNEL</td>
<td>①,②,④,⑤,⑥(=P2 CH)</td>
</tr>
<tr>
<td>5</td>
<td>OPERATOR SELECTABLE</td>
<td>FIXED</td>
<td>②,③,④,⑤,⑥,⑦,⑧,⑨</td>
</tr>
<tr>
<td>6</td>
<td>SELECTED CHANNEL</td>
<td>FIXED</td>
<td>②,③,④,⑤(=P1 CH)</td>
</tr>
<tr>
<td>7</td>
<td>OPERATOR SELECTABLE</td>
<td>NONE</td>
<td>②,③,④,⑤,⑥,⑦,⑧,⑨</td>
</tr>
<tr>
<td>8</td>
<td>SELECTED CHANNEL</td>
<td>NONE</td>
<td>②,③,④,⑤,⑥,⑦,⑧,⑨</td>
</tr>
<tr>
<td>9</td>
<td>OPERATOR SELECTABLE</td>
<td>OPERATOR SELECTABLE</td>
<td>②,③,④,⑤,⑥,⑦,⑧,⑨</td>
</tr>
<tr>
<td>10</td>
<td>OPERATOR SELECTABLE</td>
<td>SELECTED CHANNEL</td>
<td>③,④,⑤(=P2 CH)</td>
</tr>
<tr>
<td>11</td>
<td>SELECTED CHANNEL</td>
<td>OPERATOR SELECTABLE</td>
<td>③,④,⑤(=P1 CH)</td>
</tr>
<tr>
<td>12</td>
<td>NONE</td>
<td>NONE</td>
<td>③,④,⑤,⑥,⑦,⑧,⑨</td>
</tr>
</tbody>
</table>

* **REVERT CHANNEL ASSIGNMENTS**

①Priority 1 Channel  
②Priority 2 Channel  
③Last Called Channel  
④Last Used Channel  
⑤Selected Channel ( =Priority 1 Channel or Priority 2 Channel )  
⑥Priority 1 Channel > Priority 2 Channel (Go to P1 CH if one exists, if not, go to P2 CH )  
⑦Priority 1 Channel > Last Called Channel (Go to P1 CH if one exists, if not, go to last called CH )  
⑧Priority 1 Channel > Last Used Channel (Go to P1 CH if one exists, if not, go to last used CH )  
⑨Priority 1 Channel > Selected Channel (Go to P1 CH if one exists, if not, go to selected CH )  
⑩Priority 2 Channel > Last Called Channel (Go to P2 CH if one exists, if not, go to last called CH )  
⑪Priority 2 Channel > Last Used Channel (Go to P2 CH if one exists, if not, go to last used CH )  
⑫Priority 2 Channel > Selected Channel (Go to P2 CH if one exists, if not, go to selected CH )  
⑬P1 CH > P2 CH > Last Called Channel (Go to P1 CH if one exists, if no P1 CH exists, go to P2 CH,  
if no P2 CH exists, go to last called CH )  
⑭P1 CH > P2 CH > Last Used Channel (Go to P1 CH if one exists, if no P1 CH exists, go to P2 CH,  
if no P2 CH exists, go to last used CH )  
⑮P1 CH > P2 CH > Selected Channel (Go to P1 CH if one exists, if no P1 CH exists, go to P2 CH,  
if no P2 CH exists, go to selected CH )
GROUP SCAN
Selects either Single Group Scan or Multi Group Scan. However, it works only with the full-featured control head configuration.

a. Single Group Scan
Selecting Single Group Scan allows you to scan only those channels in the group selected with the Group switch for which "Add" has been set.

b. Multi Group Scan
Selecting Multi Group Scan allows you to scan only those channels which satisfy two criteria:
1) they belong to a group for which "Add" has been set with the Group Del/Add setting, and
2) "Add" has been set for the channels as well.

RESUME TIME
Specifies the time interval from loss of carrier until start of scan when scanning has stopped. The setting range is from 0 to 5.0 seconds, and is settable in increments of 0.1 second. The default value is 0.8 seconds.

LOOK BACK TIME
The cycle time for scanning priority channels when scanning of other channels has stopped.

a. LOOK BACK TIME A
The time interval during which there is no carrier for the PRIORITY CH. The setting range is from 350 to 2900 milli seconds, and is settable in increments of 50 milli seconds. The default value is 350 milli seconds.

b. LOOK BACK TIME B
The time interval during which there is a carrier for the PRIORITY CH, but the signaling (DT, DCT) is different. The setting range is from 350 to 6450 milli seconds, and is settable in increments of 100 milli seconds. The default value is 2050 milli seconds.

REVERT CHANNEL
The channel to which the transceiver returns when scanning has stopped. To stop a scan, put the microphone in the off-hook state. The channels which can be set as revert channels are determined by the PRIORITY CH setting. If you change the PRIORITY CH settings, the revert channel setting returns to its default value. For details, see "PRIORITY CH".

Feature Option
You can set ten features as software options with the Feature Option selection. Feature Option includes ten items which can be set: Time Out Timer, Busy Channel Lockout, Off-Hook Decode Enable, Power On Tone, Control Tone, Warning Tone, Roll Over, Priority CH Temporary Delete, Monitor Other TX Audio, and Operator Selectable Tone Code. Each of these items is explained separately below.

Time Out Timer
Sets the Time Out time for transmission. It can be set to OFF (unlimited), or from 15 to 225 seconds. This setting can be specified in 15-second steps, and the default setting is 180 seconds.

BUSY CHANNEL LOCKOUT
Prohibits transmission if there is a carrier on the selected channel which does not match the tone or code for the channel. The default is "No".
OFF HOOK DECODE ENABLE
Normally, the transceiver enters monitor state when it is off hook; QT/DQT and the decoding functions for other signaling options are disabled, and the received signals are output to the speakers. However, this function enables QT/DQT and the decoding functions for other signaling options even when the microphone is off hook. Functions such as stopping a scanning operation by taking the microphone off-hook, and restarting the scanning operation by placing the microphone on-hook are not changed.

ROLL OVER
Sets whether the CH Select Knob will be set for endless operation or not. If YES is selected, the knob is set for endless operation. If NO is selected, the knob will end at "Stop Dead End".

POWER ON TONE
Beep tone at radio power up.

CONTROL TONE
Key and selector knob echo-back beeps.

WARNING TONES
PLL unlock, Time-out timer & busy ch lockout alert tones.

OVERRIDE CHANNEL TEMPORARY DELETE
Allows you to temporarily delete priority channels while scanning them. The default setting is "NO".

OPERATOR SELECTABLE TONE (QT/DQT)
Sets 16 types of tones or codes that can be adjusted by the operator in addition to the signalling (QT/DQT) set for each channel. You must assign OPT (operator Selectable) to a control head key to use this function.

OTX AUDIO MONITOR
Works only with the dual control head configuration. This function monitors audio when the transmission is performed by the other control head.

Embedded Message
This message can be written to the radio making it convenient to use for an electronic serial number, user name and address management.
8-2 Key Selection

This section describes how to set the key assignments.

1. Open the Edit menu window. (section 5-2)

2. Move the cursor to "Key Selection" with the up- or down-arrow key, and press the Enter key. You can also use the Quick Key for the selection. The window shown in Figure ④ will open if you have a basic control head configuration, and the window shown in Figure ⑤ will open if you have a full control head configuration.

![Figure ④]

3. Use the arrow keys to move the cursor to the key you wish to assign a function to, and press the Enter key. The window shown below then opens.

```
<table>
<thead>
<tr>
<th>Key Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>space : Not Used</td>
</tr>
<tr>
<td>Mon : Monitor</td>
</tr>
<tr>
<td>scN : Scan</td>
</tr>
<tr>
<td>Pa : Public Address</td>
</tr>
<tr>
<td>Ha : Horn Alert</td>
</tr>
<tr>
<td>Ta : Talk Around</td>
</tr>
<tr>
<td>lc : Intercom</td>
</tr>
<tr>
<td>An : Alphanumeric</td>
</tr>
<tr>
<td>Sp : Speaker Switch</td>
</tr>
<tr>
<td>D / a : Delete / Add</td>
</tr>
<tr>
<td>Opt : Voice Scrambler</td>
</tr>
<tr>
<td>aux : Auxiliary</td>
</tr>
</tbody>
</table>
```
Select the desired function with the up- or down-arrow key or the Quick Key (section 3-1 or 3-2). See ""Key Function Descriptions"" in Section 3-1 for a description of the functions of the items in this window. Once you have completed the setting, the selected function is displayed in the box and the cursor then moves to the next item.

Press the Alt key to close the Key Selection window and return your monitor to the previous screen.

If you set the OPT key or the AUX key, you must select a function for it. Press the F10 key. The window shown below then opens.

<table>
<thead>
<tr>
<th>OPT KEY</th>
<th>AUX KEY</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>[ Voice Scrambler ]</td>
</tr>
<tr>
<td>Voice Scrambler</td>
<td>Operator Selectable</td>
</tr>
<tr>
<td>Operator Selectable</td>
<td>Tone</td>
</tr>
<tr>
<td>Operator Selectable</td>
<td>Tone</td>
</tr>
</tbody>
</table>

Use the up/down and left/right-arrow keys to select the function you wish to set. (section 3-1)

Note: The same function cannot be assigned to both the OPT key and the AUX key concurrently.
8-3 Scan Information

This section describes how to set Scan Information. First, open the Edit menu window (section 5-2). Next, move the cursor to "Scan Information" with the up- or down-arrow key, and press the Enter key. You can also use the Quick Key for the selection. The Scan Information window shown below opens. The operations to set each of the items in this window are described below. When you have completed the setting for each item, the cursor moves to the next item. When you are finished, press the Alt key to close the Scan Information window. The display then returns to the previous screen.

<table>
<thead>
<tr>
<th>Scan Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority 1       : [ ] None</td>
</tr>
<tr>
<td>Priority 2       : [ ] None</td>
</tr>
<tr>
<td>Group Scan       : [ ] Single</td>
</tr>
<tr>
<td>Resume Time      : [ ] 0.8 Sec ( 0.0 ~ 5.0 Sec )</td>
</tr>
<tr>
<td>Look Back Time A : [ ] 350 msec ( 350 ~ 2900 msec )</td>
</tr>
<tr>
<td>Look Back Time B : [ ] 2025 msec ( 350 ~ 5450 msec )</td>
</tr>
<tr>
<td>Reset Channel    : [ ] Selected Channel</td>
</tr>
</tbody>
</table>

• Priority 1
  1. Move the cursor to "Priority 1" with the up- or down-arrow key, and press the Enter key. The settings window opens.

  2. Select the setting you wish to specify with the up- or down-arrow key or the Quick Key. (section 3-1 or 3-2)

  (or Press the F2 key or the space bar to move through the function selections one by one. Select the function, and press the Enter key.)

• Priority 2
  1. Move the cursor to "Priority 2" with the up- or down-arrow key, and press the Enter key. The settings window then opens.

  2. Select the setting you wish to specify with the up- or down-arrow key or the Quick Key. (section 3-1 or 3-2)

  (or Press the F2 key or the space bar to move through the function selections one by one. Select the function, and press the Enter key.)

• Group Scan
  1. Move the cursor to "Group Scan" with the up- or down-arrow key, and press the Enter key. The settings window then opens.

  2. Select the setting you wish to specify with the up- or down-arrow key or the Quick Key. (section 3-1 or 3-2)

  (or Press the F2 key or the space bar to move through the function selections one by one. Select the function, and press the Enter key.)

• Resume Time
  1. Move the cursor to "Resume Time" with the up- or down-arrow key.

  2. Enter the desired time, and press the Enter key

  (or Press the F2 key to change the setting in 0.1-second increments. Select the desired time, and press the Enter key.)

46
Look Back Time A
1. Move the cursor to "Look Back Time A" with the up- or down-arrow key.

2. Select the desired time, and press the Enter key
   (or Press the F2 key to change the setting in 50-millisecond increments. Select the desired time, and press the Enter key)

Look Back Time B
1. Move the cursor to "Look Back Time B" with the up- or down-arrow key.

2. Select the desired time, and press the Enter key
   (or Press the F2 key to change the setting in 100-millisecond increments. Select the desired time, and press the Enter key)

Revert Channel
1. Move the cursor to "Revert Channel" with the up- or down-arrow key, and press the Enter key. The settings window then opens.

2. Select the revert channel you wish to specify with the up- or down-arrow key or the Quick Key, (section 3-1 or 3-2)
   (or Press the F2 key or the space bar to move through the selections one by one. Select the revert channel, and press the Enter key)
8-4 Feature Option

This section describes how to set the Feature Option items. First, open the Edit menu window (section 5-2). Next, move the cursor to “Feature Option” with the up- or down-arrow key or the Quick Key, and press the Enter key. The Feature Option window shown below opens. The operations to set each of the items in this window are described below. When you have completed the setting for each item, the cursor moves to the next item. When you are finished, press the Alt key to close the Feature Option window. The display then returns to the previous screen.

<table>
<thead>
<tr>
<th>Feature Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Out Timer</td>
<td>[ 16 ] OFF, 15 – 225 sec</td>
</tr>
<tr>
<td>Busy Channel Lockout</td>
<td>[ Yes ]</td>
</tr>
<tr>
<td>OFF Hook Decode Enable</td>
<td>[ Yes ]</td>
</tr>
<tr>
<td>Power ON Tone</td>
<td>[ Yes ]</td>
</tr>
<tr>
<td>Control Tone</td>
<td>[ Yes ]</td>
</tr>
<tr>
<td>Warning Tone</td>
<td>[ Yes ]</td>
</tr>
<tr>
<td>Roll Over</td>
<td>[ Yes ]</td>
</tr>
<tr>
<td>Scrambling Code Selectable</td>
<td>[ NO ]</td>
</tr>
<tr>
<td>Priority Temporary Delete</td>
<td>[ NO ]</td>
</tr>
<tr>
<td>User Selectable Code</td>
<td>[ ]</td>
</tr>
</tbody>
</table>

- **Time Out Timer**
  1. Move the cursor to “Time Out Timer” with the up- or down-arrow key.
  2. Enter the desired time, and press the Enter key.
  (or Press the F2 key to change the setting in 15-second increments. Select the desired time, and press the Enter key.)

- **Busy Channel Lockout**
  1. Move the cursor to “Busy Channel Lockout” with the up- or down-arrow key, and press the Enter key. The settings window then opens.
  2. Select either [Yes] or [No] with the up- or down-arrow key or the Quick Key. (section 3-1 or 3-2)
  (or Press the F2 key or the space bar to alternate between the [Yes] and [No] settings. Select either [Yes] or [No], and press the Enter key.)

- **OFF Hook Decode Enable**
  1. Move the cursor to “OFF Hook Decode Enable” with the up- or down-arrow key, and press the Enter key. The settings window then opens.
  2. Select either [Yes] or [No] with the up- or down-arrow key or the Quick Key. (section 3-1 or 3-2)
  (or Press the F2 key or the space bar to alternate between the [Yes] and [No] settings. Select either [Yes] or [No], and press the Enter key.)

- **Power ON Tone**
  1. Move the cursor to “Power ON Tone” with the up- or down-arrow key, and press the Enter key. The settings window then opens.
  2. Select either [Yes] or [No] with the up- or down-arrow key or the Quick Key. (section 3-1 or 3-2)
  (or Press the F2 key or the space bar to alternate between the [Yes] and [No] settings. Select either [Yes] or [No], and press the Enter key.)
● Control Tone
1. Move the cursor to “Control Tone” with the up- or down-arrow key, and press the Enter key. The settings window then opens.

2. Select either [Yes] or [No] with the up- or down-arrow key or the Quick Key. (section 3-1 or 3-2)
(or) Press the F2 key or the space bar to alternate between the [Yes] and [No] settings. Select either [Yes] or [No], and press the Enter key.)

● Warning Tone
1. Move the cursor to “Warning Tone” with the up- or down-arrow key, and press the Enter key. The settings window then opens.

2. Select either [Yes] or [No] with the up- or down-arrow key or the Quick Key. (section 3-1 or 3-2)
(or) Press the F2 key or the space bar to alternate between the [Yes] and [No] settings. Select either [Yes] or [No], and press the Enter key.)

● Roll Over
1. Move the cursor to “Roll Over” with the up- or down-arrow key, and press the Enter key. The settings window then opens.

2. Select either [Yes] or [No] with the up- or down-arrow key or the Quick Key. (section 3-1 or 3-2)
(or) Press the F2 key or the space bar to alternate between the [Yes] and [No] settings. Select either [Yes] or [No], and press the Enter key.)

● Priority Temporary Delete
1. Move the cursor to “Priority Temporary Delete” with the up- or down-arrow key, and press the Enter key. The settings window then opens.

2. Select either [Yes] or [No] with the up- or down-arrow key or the Quick Key. (section 3-1 or 3-2)
(or) Press the F2 key or the space bar to alternate between the [Yes] and [No] settings. Select either [Yes] or [No], and press the Enter key.)
Operator Selectable Tone (QT / DQT)

1. Move your cursor to "Operator Selectable Tone" with the up- or down-arrow key, and press the Enter key. The settings window shown below opens.

<table>
<thead>
<tr>
<th>Code</th>
<th>Decode</th>
<th>Encode</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. Move the cursor to the location you wish to input a code with the up- or down-arrow key.

3. Enter the code you wish to specify, and press the Enter key.
   (or Press the F2 key to open the Tone window. Select the desired tone from this window, and press the Enter key.)

4. Once you have finished entering all the codes, press the Alt key. The settings window closes, and the display returns to the previous screen.

Monitor Other TX Audio

1. Move the cursor to "Monitor Other TX Audio" with the up- or down-arrow key, and press the Enter key.

2. Select either [Yes] or [No] with the up- or down-arrow key or the Quick Key. (section 3-1 or 3-2)
   (or Press the F2 key or the space bar to alternate between the [Yes] and [No] settings. Select either [Yes] or [No], and press the Enter key.)
9 Program

Allows you to read data from the transceiver, and write data to the transceiver.
(Make sure that transceiver is set to the programming mode. Refer to Section 1-2)

Contents of this chapter

<table>
<thead>
<tr>
<th>9-1 Read</th>
<th>9-2 Write</th>
</tr>
</thead>
<tbody>
<tr>
<td>................................. P51</td>
<td></td>
</tr>
<tr>
<td>................................. P52</td>
<td></td>
</tr>
</tbody>
</table>

9-1 Read

1 Open the Program menu window. (section 5-2)

2 Move the cursor to "Read" with the up- or down-arrow key, and press the Enter key. The window shown below then opens.

   \[
   \begin{array}{|c|c|}
   \hline
   \text{Read Data From The Radio} & \\
   [ \text{OK} ] & [ \text{Cancel} ] \\
   \hline
   \end{array}
   \]

3 Select either [OK] or [CANCEL] with the left- or right-arrow key or the Quick Key (section 3-1 or 3-2). If you select [OK], data are read from the transceiver. The window shown below then opens, indicating that the procedure has been completed.

   \[
   \begin{array}{|c|}
   \hline
   \text{Done Reading The Radio Data} \\
   \text{Hit any key} \\
   \hline
   \end{array}
   \]

   If you select [CANCEL], data are not read, the window closes, and the display returns to the previous screen.

Note The window shown below opens if your computer and transceiver are not connected properly. In this case, you must check the connection to see whether the equipment is connected properly or not.

   \[
   \begin{array}{|c|c|}
   \hline
   \text{ERROR} & \\
   \text{Check connection. Retry or Cancel} & [ \text{Retry} ] [ \text{Cancel} ] \\
   \hline
   \end{array}
   \]

Select either [OK] or [CANCEL] with the left- or right-arrow key or the Quick Key (section 3-1 or 3-2). If you select [ Cancel ], the display returns to the program menu window. Set the transceiver in programming mode. Verify that the transceiver and the computer are connected properly with KPG-4 and select [ Retry ].

51
9-2 Write

1. Open the Program menu window. (section 5-2)

2. Move the cursor to "Write" with the up- or down-arrow key, and press the Enter key. The window shown below then opens.

   Write Data To The Radio.

   [OK] [Cancel]

3. Select either [OK] or [CANCEL] with the left- or right-arrow key or the Quick Key (section 3-1 or 3-2). If you select [OK], data are written to the transceiver. The window shown below then opens, indicating that the procedure has been completed.

   Done: Writing The PC Data
   Hit any key

If you select [CANCEL], data are not written to the transceiver, the window closes, and the display returns to the previous screen.

**Note** The window shown below opens if your computer and transceiver are not connected properly. In this case, you must check the connection to see whether the equipment is connected properly or not.

**ERROR**

   Check connection. Retry or Cancel

   [Retry] [Cancel]

Select either [OK] or [CANCEL] with the left- or right-arrow key or the Quick Key (section 3-1 or 3-2). Set the transceiver in programming mode. Verify that the transceiver and the computer are connected properly with KPG-4 and select [Retry]. If you select [Cancel], the display return to the program menu window.
10 Set up

The Set-up allows you to set the communication port, display color, and Help path.

Contents of this chapter

<table>
<thead>
<tr>
<th>10-1 Communication port</th>
<th>P53</th>
</tr>
</thead>
<tbody>
<tr>
<td>10-2 Display color</td>
<td>P54</td>
</tr>
<tr>
<td>10-3 Help Path</td>
<td>P55</td>
</tr>
</tbody>
</table>

10-1 Communication port

Sets the communication port, either COM 1 or COM 2, for the connection between the transceiver and your computer.

1. Open the Setup menu window. (section 5-2)

2. Move the cursor to "Communication port" with the up- or down-arrow key, and press the Enter key. The window shown below then opens.

   SET UP Communication Port

   [ com 1 ] [ com 2 ]

3. Select either [COM 1] or [COM 2] with the left- or right-arrow key or the Quick Key (section 3-1 or 3-2).

   **Note** If there is only a COM 1 port on your computer, the window shown below opens. You can press any key. The communication port is automatically set to COM 1.

   There is no COM 2 Port.
   Now selected COM 1 PORT.
   HIT any key.

4. Once you have completed the setting, press the ESC key. The window closes, and the display returns to the CHANNEL INFORMATION screen.
10-2 Display color

Display Color can be set to either color mode or black and white mode. If you select color mode, you can change the colors of the menu bar, windows, and so forth.

1. Open the Setup menu window. (section 5-2)

2. Move the cursor to "Display Color" with the up- or down-arrow key, and press the Enter key. The window shown below then opens.

   Display Color Mode
   
   [ COLOR ] [ Black & White ]

3. Select either [COLOR] or [Black & White] with the left- or right-arrow key or the Quick Key. (section 3-1 or 3-2)

4. If you select [Black & White], your display screen is set to display in black and white. If you select [COLOR], the window shown below opens.

   Set up Display Color

   Display Back Color : Blue
   Input Data Color : Brown
   Feature High/Light Color : Magenta
   Screen Border Info. Color : Green
   Windows Menu Color : Cyan
   General Message Color : Red
   Windows Color : Lightgray

5. Move the cursor to the item you wish to set a color to with the up- or down-arrow key, and press the Enter key. The following window opens.

   black
   blue
   green
   cyan
   red
   magenta
   brown
   lightgray

6. Select the desired color with the up- or down-arrow key or the Quick Key (section 3-1 or 3-2). Pressing the F10 key, then the Enter key returns all colors to their initial settings.

7. Repeat steps 5 and 6 to set the colors for the other items.

8. Once you have completed all the settings, press the ESC key. The window closes, and the display returns to the CHANNEL INFORMATION screen.
10-3 Help Path

Use Help Path to set the drive and path name of the Help File.

1  Open the Setup menu window. (section 5-2)

2  Move the cursor to "Help Path" with the up- or down-arrow key, and press the Enter key. The window shown below then opens.

   Setup Drive & Path for Help File
   Drive & Path : A:\KPG7D

3  Enter the drive and path name directly from the keyboard (section 3-3). The window closes, and the display returns to the CHANNEL INFORMATION screen.

Note However, if there is no the drive and path name you have entered, the window shown below opens. Verify whether or not the drive and path name exists. Press the Alt key and enter the correct drive and path name.

   ERROR 1
   Drive & Path not found
   Hit any key

Note However, if there is no help file at the location indicated by the drive and path name you have entered, the window shown below opens. Verify whether or not the help file exists at that location. Press the Alt key and enter the correct drive and path name.

   ERROR 1
   Help file not found. Hit any key.
11  F1 = Help

General Help and Keyboard Help are accessed from the F1 = Help menu. General Help shows the screen organization. Keyboard Help shows how to use the keyboard.

Contents of this chapter

<table>
<thead>
<tr>
<th>11-1 General Help</th>
<th>11-2 Keyboard Help</th>
<th>11-3 Keys you can use in the Help screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>P56</td>
<td>P56</td>
<td>P57</td>
</tr>
</tbody>
</table>

11-1  General Help

1  Open the F1 = Help menu window. (section 5-2)

2  Move the cursor to "General Help" with the up- or down-arrow key, and press the Enter key. The Help screen is then displayed. If you press the Alt key, the Help screen closes, and the display returns to the previous screen.

Along the top border of the main program screen (Channel Info.) are the "drop down" menus (press ALT; use the cursor keys ← → ↓ to select a program section. Help is available for each menu by pressing the #1 function key. Pressing F1 while in the channel Info. screen will load it's Help screen. To get familiar with the computer key functions used in the KPG-7D, hit ALT now; select Keyboard Help; hit ENTER. Within a Help screen use cursor up / down to scroll; F 6 to print a hardcopy; and ESC or ALT to escape the screen. Refer to the KPG-7D Instruction Manual for additional help.

**Basic Use Instructions (use F 1 for Help in each program section below)**

A. [ CREATING PROGRAM DATA FOR A MOBILE ]
1. Open "MODEL" menu and select the appropriate model type.
2. Open "EDIT - Key Selection" menu and assign a function to keys on the control head. (hint: use ALT to return to EDIT menu)
3. Open "EDIT - Scan Information" menu; set SCAN features & parameters.
4. Open "EDIT - Feature Option" menu; set the general built-in features.
5. Hit ESC: the cursor will move the main screen, "CHANNEL INFORMATION"

11-2  Keyboard Help

1  Open the F1 = help menu window. (section 5-2)

2  Move the cursor to "Keyboard Help" with the up- or down-arrow key, and press the Enter key. The Help screen is then displayed. If you press the Alt key, the Help screen closes, and the display returns to the previous screen.

Currently available keys functions are displayed on the bottom screen border

ESC: returns to the main screen; Channel Information (exits menus & sub-screens).
ALT: "Go to Menu" or "Go back" to previous screen.
CURSOR Keys: moves cursor within a data input field; scrolls help screens.
PgUp & PgDn: pages up / down Channel Group & Help screens.
F 1: Opens a Help screen.
F 2: through F 10: Selects labeled functions in shown at screen bottom.
F 2: Toggles Yes / No or increments selection in data fields.
Shift + F 2: Decrements selection in data fields.
F 3: Copies the current channel data to another channel.
F 4: Copies a RX frequency column entry to the TX frequency column.
F 5: Prints the current Help screen.
F 7: Next page / channel group (same as page up)
F 8: Previous page / channel group (same as page down)
F 10: Priority channel set
Shift + F 3: Copies an entire channel group to other channel group.
11-3 Keys you can use in the Help screen

You can use the following keys in the Help screen:

- [Alt] Key ..................... Exits Help and returns to the previous screen.
- [ESC] Key ...................... Returns the display to the CHANNEL INFORMATION screen.
- Up arrow Key ................. Scrolls the screen up.
- Down arrow Key ............... Scrolls the screen down.
- [F7] Key (Page Down) ........ Displays the next page.
- [F8] Key (Page Up) ........... Displays the previous page.